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Introduction to EthosCE Administration 
 

EthosCE is both a content management system as well as a learning management system. It is built upon two 
open source platforms, Drupal (CMS) and Moodle (LMS). Both of these platforms have very active 
development communities that are actively working to fix bugs, close security holes, and add functionality 
to the Core platforms. Because EthosCE uses these core platforms, it benefits from this development 
community. 

Most of the administrative actions of the system happen within Drupal, which provides the look and feel of 
the site as well as the CMS functionality. Moodle is an industry leading LMS, and we have worked to provide a 
lot of the administrative screens through Drupal for a more integrated experience. 

 
For this user manual, it is important to have a user account with administrative permissions. As the 
administrator, you will be able to create and manage various aspects of your site. 
 
To access the admin menu, click on the icon towards the top left of your site. It will resemble a wrench. 
When you click the icon, the admin menu will drop down. 
 

         

 
 
If you need additional help, additional instructions may be provided on Moodle and Drupal interfaces by 

clicking on the ‘?’ icons.  
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Terminology 
Overview: 
This section contains definitions for terms that will be used in the training session.  

Important things to know: 
In this section we will show you how to clear your cache and the site cache, which can be important when 
web development is underway. 

List of Terms 
Block - Chunks of content that sit inside a page can contain nodes, views, menus or static content. 
 
Browser - Desktop or mobile software that renders the HTML into a viewable page. For example, 
Internet Explorer, Firefox, Google Chrome or Safari. 
 
Cache - a way of saving commonly used elements into memory so that they don't have to be 
reprocessed by the server and database. This delivers the page much faster, but can cause changes 
not to appear immediately. Caching can happen at the database and browser. 

 
How to clear your cache 
In Internet Explorer, select from the top drop-down: Tools > Internet Options > Delete. 
Check “Temporary Internet Files” and click delete.  
 
How to clear the website cache 
As the admin user navigate to /admin/settings/performance. Scroll to the bottom of the 
page and click “Clear cached data.” 

 
Course Objects - A part of a course such as a pre-test, webcast, evaluation or certificate. 
Represented with icons in the course layout. 
 
Learning Group - Learning groups group together users with related educational content such as 
courses, discussions and news items around a common theme. 

 
Navigation Menus - A list of links usually in the top or left of the page. Referred to as a "left nav" or 
a "top nav" 
 
Node - An item of content, like a page, blog entry, course description, etc. 

 

Panels - A custom page layout made up of nodes, blocks, views and other content. 

 
Path - The part of the URL after the base address. eg. ( http://www.cnn.com/video/ ) 
 
Tabs - A smaller, secondary horizontal menu usually formatted to look like folder tabs. 
 
Token - A placeholder for data that is replaced with actual data. [firstname] 



 Terminology 
 

  Version 3.3 – November 2013                                                                                              Page 8 of 110 

 
Vertical Tabs - A smaller, secondary menu that is stacked vertically. 
 
Views - A "view" or list of content pulled from the database, filtered and formatted. 
 
Web Database - Software that stores site settings in memory or storage, such as user data, pages, 
menus. Usually MySQL. 

 
Web Server - Software that delivers the HTML web page to your browser. Usually Apache. 
 
Weight - Weight controls the order of multiple items. Each item has a number that represents 
where in the set of it appears. Bigger numbers “sink” to the bottom. Lower or negative number 
“float” to the top. 
 

 

 
 
Course Objects: 
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Managing Menus 
Overview: 
This section contains instructions for how to add menu items to your site. 
 

Important things to know: 
If you add a page to a menu from the “edit menu” interface, you will need to know the path to the page. 
You can find the path by loading the page and looking in the address bar. 

1. Changing the Menu Order 
Step 1. In the admin menu, select “Administer,” then “Site building,” then “Menus.” 
 
Step 2. Select the menu to edit. The top nav menu is usually called “Primary links” 
 

 

 
 
 

 
Step 3. Drag and drop the menu item to reorder. Set the menu item to ‘Expanded’ if you would like it to 
expand as a dropdown. You must click “Save configuration” when finished.  
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2. Adding a New Menu Item 
Step 1. Click “Add item” as shown in the above image. 

 
Step 2.  Add the path and title. Select the menu the new item is going to appear in. If you have been editing 
the “Primary links” (top nav) menu, it should already be selected.  

 
Step 3.  Click Save when finished. You may now drag and drop the new item to re-order it. 
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Creating Site Content 
Overview: 
This section contains instructions for how to add basic content to your site. 

Important things to know: 
This section only covers “static” content, and does not include courses. 
 
 

1. Page Creation 
Step 1. In the admin menu, select “Create content”, then “Page”. 

 
 
Step 2. Enter Basic Information 

Enter a title and description for your page. Depending on your site’s configuration, you may be able to 
format your text using the text editor. If you would like to add the page to a navigation menu, you can do 
this now. 
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2. Menu Item 
 
Step 1. To create a menu item for your page, first click on the “Menu Settings” tab. 

 
 

Step 2. Enter a Menu Link Title. This is the title that will appear in your navigation. If you do not enter a 
title, your page will not show up in the navigation. 

 
 
Step 3. Click on the dropdown under ‘Parent Item’ and select the link you would like your page to appear 
besides or beneath. “<Primary Links>” is typically where the main navigational items are listed. 
 
You can use the “weight” dropdown to set the position at which the menu item will appear in the menu: 
Higher numbers sink to the bottom. Lower (or negative) numbers float to the top. 
 
Please see the “Managing Menus” section of the manual for instructions on how to order your menu items. 
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Managing Site Content 
Overview: 
This section contains instructions for how to find and edit content. 

 
Step 1. In the admin menu, select “EthosCE admin,” then “Manage Content”. 

 
  
 
Step 2. You can search for keywords that are in the course title, limit your search to type(course, news 
item, page, etc), and search for published/unpublished content. 

 

Step 3. You can also perform bulk operations to the content listed by checking the checkbox next to the 
content and selecting a bulk operation from the dropdown. Click “Execute” to perform the operation. 

 
 
Step 4. You can edit the content by clicking on the “edit” link that is located next to each piece of content 
listed. 
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Managing Your Homepage
If your homepage does not include the standard dashboard, the documentation for editing your home page 
will be included in separate documentation with your site’s customizations. 

 

Managing Your Homepage - Standard 

1. Dashboard 
Step 1. To access the dashboard, go to your homepage and go to the admin menu. Click on “Dashboard” and 
then ‘Edit”. 

  

Step 2. You will then be able to move or remove sections/blocks around on the page. Use the icons that 
appear in the upper right hand of each section. Click and drag the + tool to move a section. Note that you 
can only move certain blocks into certain section due to a fixed height and width. 
Click the x tool to remove a section. 

 

Step 3. Go to the admin menu and choose a category to add a different section to the page.  

 
 

Atrium Calendar Category: 

• Mini Calendar - This mini calendar will pull in events and live courses automatically. Users can 
access a full calendar from this block as well. Please note that the mini calendar will appear to be a 
list of days of the week until the Dashboard is saved. 
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Box Category:  

• Add custom box - If you would like to add a custom block to your homepage, you can choose the 
category ‘Boxes’ and drag in a customizable box. You can add your own content (images, text, 
links,etc) into this box. 

EthosCE Courses Category: 

• Recent Courses - This block pulls in a list of the most recently created published courses. 

• Upcoming Courses - This blocks pulls in a list of courses with a start date in the future. 

• Featured Courses - This block pulls in a list of courses that are set to be featured courses. Courses 
need to have the ‘promoted to front page’ and ‘sticky at top of lists’ options enabled under the 
Publishing section during course creation.  

Courses in this block can be re-ordered by using the draggable handles and clicking ‘Save Order’. 
You do not need to be editing the Dashboard in order to re-order courses. 

 
 

EthosCE Discussions: 

• Recent Discussions - This block pulls in a list of the most recent published discussion topics. 

EthosCE News: 

• Recent News - This block pulls in a list of the most recent published news items. 

EthosCE Reports: 

• Pending Activities - This block pulls in a list of the logged-in user’s list of pending activities. 

• Completed Activities - This block pulls in a list of the logged-in user’s list of completed activities. 

EthosCE Slideshow: 

• Slideshow - This block pulls in published slides. If slides are created outside of a learning group, they 
will automatically populate into the homepage slideshow. If slides are created in the context of a 
learning group, slides will not appear on the homepage and remain with their group’s slideshow. See 
next section on slide creation. 
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Step 4. To add a block to the page, click and drag one of the blocks onto the page. Any listing with the block 

icon:  

Note: If you accidentally deleted a section of the homepage, you 
can go to the category and re-add it to the page. 

 

 

Step 5. If you would like to add a custom block to your homepage, you can choose the category ‘Boxes’ and 
drag in a customizable box. You can add your own content(images, text, links,etc) into this box. 

Step 6. Click “Done” in the admin menu and then “Save Changes” when finished. 

2. Managing Slides on Homepage Promo 

Step 1. Navigate to your homepage. In the admin menu, select “Create Content,” then “Slide”. 

 

Step 2. Fill in the required fields. To upload an image for your slide, go to the IMAGE section, browse for an 
image, and upload to the server. 

 

 
Step 3. You may re-order slides by adding a numerical value to the ‘Order’ field. Each slide of the slideshow 
must have a number in the order field to re-order slides. Slide with order number as 0 will appear first in the 
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sequence. 

 

 

 
Step 4. Click Save when finished. This will automatically add a new slide to the homepage slideshow. 

Step 5. To edit a current slide, click on the “Edit” link that is on your slide when viewing the slideshow.  

 

3. Adding News Items to Homepage 

Step 1. Navigate to your homepage. In the admin menu, select “Create Content,” then “News Item,” if you 
want to create a news item that is not associated with a group. 

 

Step 2. Fill in the required fields and Save. Your news item will appear on the homepage, if you have the 
‘Recent News’ block on your homepage dashboard. 
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Calendar - Events 
Live Courses and events appear on the calendar. In this section, you will learn how to create an event and 
manage the calendar. 

1. Creating an Event 
 
Step 1. In the admin menu, click on “Create Content,” and then “Event”. 

 
 
 
Step 2. Fill in the required fields. Give your event a date and description. Save when finished. 
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2. Managing Calendar 
Step 1. Navigate to the calendar. Your events and live courses will appear on the dates that you had entered 
in the Event date fields when creating your event and live courses. Click on the event to see the event 
details. 

 
 
Step 2. Click on the “Previous” and “Next” links to view months. 
 
Step 3. Click on the “Upcoming” tab to see upcoming events and live courses. 
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Learning Groups 
Overview: 
This section contains instructions for how to create a learning group.  Learning groups organize users with 
related content such as courses, discussions, and news items. 

Important things to know: 
Learning groups are public content by default. Content published inside a learning group will take the 
privacy settings of the parent group. 

 

1. Creating a Learning Group 
Step 1. In the admin menu, select “Create Content,” then “Learning Group” 

 
 
Step 2. Enter basic information. 
 

● Enter a title, description and path for your group. 
 

● Select the radio button next to the privacy option for your group. If the group is private, you will 
need to manually add members to the group for group access. 

● If you would like to change your learning group’s styles(fonts, colors, etc), the Custom CSS field may 
be used. Knowledge of CSS(Cascading Style Sheets) would be useful to implement styles to your 
learning group. 
 

● Use the menu settings if you would like to have the group appear in a menu. 
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Step 3. If you want the new group to appear in a navigation menu, add a “menu link title” and select which 
menu you would like it to appear in. 

 

 
Step 4. You can set the order that it appears in by using the 
“weight” settings: Higher numbers sink to the bottom. Lower 
(or negative) numbers float to the top. 

 
Step 5. Click “Save” when you are finished.  

Step 6. You can edit your group by clicking on the “Edit Learning Group” link on the group landing page. 
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2. Configure Group Features 
Features can be configured for individual groups. You will notice that some features are enabled or disabled 
by default, but you may always change them for individual groups. 

 
Step 1. Click the “Features” link on the group landing page, in the left nav.  

 

 
Step 2. Select which group features you would like to have in the group. For each feature you would like to 
include, click the dropdown and set it to “Enabled.” 

 
Step 3. Click “Save for ____ Group.” Click on the View tab to view your learning group. 

 

3. Group Specific Content 
To create content in your group, use the “Create Content” menu in the left navigation menu. You may then 
add courses, discussion topics, and news items to your group (if these items are enabled for the group). 
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4. Learning Group Dashboard 
You can display your content in different blocks by using the Dashboard feature. This is similar to utilizing 
the Dashboard on your standard homepage (see “Managing Your Standard Homepage” section). Site Admins 
are able to manage the Learning Group Dashboard. 

 5. Group Admin and Members 
If you plan to be the group admin, then you can skip this step. If you would like others to manage the group, 
you will need to make them a group manager. Group admins can change features and add users to a group, 
which is necessary for private groups. For custom implementations, group admins may have additional 
powers. 

 
Step 1. Click “Members” in the group admin menu. 

 

Step 2. If the user is not in the list, click the “Add members” link in the tab. 

 
Step 3. Type in the username of the user you would like to add to the group.  When you are finished, click 
“Add users”.  You can add a large number of members by adding a comma-separated list of usernames to the 
“Bulk Add” field. 
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Step 4. View  the list of group members by clicking on the “List” tab. You may “Remove membership” of a 
user by clicking the link, and you can click “Admin: Create” to change the user’s role to group admin. 
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Managing Users 
Overview: 
This section contains instructions for how to manage users. 

Important things to know: 
User profiles are separate entities from User accounts. User profiles are associated with user accounts, but 
profiles are nodes, user accounts are not. 

1. Adding a New User 
Step 1. In the admin menu, select “EthosCE admin,” then “Manage Users”. 

 
 
Step 2. Click on “+ Add user.” 

 
 
Step 3. Fill in all the fields necessary to create a user. If you would like to notify the user of the new 
account, you must check the box, “Notify user of new account.” 

 
 

When you are finished, click “Create new account.” 
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2. Finding a User: Manage 
You must be logged in as an admin to search users. 

 
Step 1. In the admin menu, select “EthosCE admin,” then “Manage Users”. 

 
 
Step 2. To narrow down your search, you can filter by role, by user’s activity, E-mail, or Name. 

 
 
Step 3. You can also perform bulk operations to the users listed by checking the checkbox next to their 
name and selecting a bulk operation from the dropdown. Click “Execute” to perform the operation. 
 

 
 
Step 4. You can edit the user or view their transcript by clicking on the links in the same row as the user’s 
information, and below ‘Operations’: 
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4. Changing a User’s Role 
Method: Find the user by following the steps in section 2(Finding a User), check the checkbox next to the 
user’s name, and use the bulk operation “Modify user roles”. 

 
 

 

Select the roles you would like to add or remove and then click “Next”.  

   

5. Roles and permissions in standard EthosCE 
Site Admin: Has the ability to access and change global settings and configurations. Can create and edit all 
forms of content, manage users, create certificates, and review global and store reports. 

Course Admin: Can create courses, activity sets, and pages. Course Admins can review reports and manage 
user enrollments at the course level. 

Reviewer: Can review reports at a course level and also take courses to review course content. 

Testing: The Testing role should be used when you are testing your site and you want to be able to create 
and then easily remove test content. It should only be used for creating test content, never for creating 
content you intend to keep.  
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When you delete a user account that has the Testing role, all content created by the user will also be 
deleted. This includes all pages, discussions, news, courses, activity sets and other content.  

Note: In order to delete the test content, you must delete by clicking on My Account > Edit > Delete 
Account. 

The Testing role is additive. It should be used in combination with the other roles in the system. So, if you 
wanted to test creating courses, you would create an account with both the Course Admin and Testing roles. 

When logged in as a Testing user, you will see a message whenever you are creating content so that you are  
aware that you have the Testing role.  

 

Student: A student user has limited permissions and can enroll and take courses. They do not see the Admin 
wrench toolbar and cannot create content. 

6. Viewing a Users Purchase History and Transcript 
Search for the user using the method described in Section 2.  You can view the user’s transcript by clicking 
on the “view transcript” link in the same row as the user’s information, and below ‘Operations’. 
 

 

 
Click the “Orders” tab to view the user’s order history. 
 

 

7. Merging Users 
When a user creates two accounts, you can merge the user’s records into a selected account and delete the 
duplicate account. When you merge one account into another, all the first account’s course completion 
records are moved and the initial account is deleted. 
 
Step 1. In the admin menu, select “EthosCE admin,” then “User Merge”. 
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Step 2. Search for the first user by E-mail, First Name, Last Name, or Username and then click on “Search”. 

 

 
Step 3. Your user should then be listed. Click on the radio button next to your user, which will then bring up 
the ‘Merge To’ section. 
 

 

 
Step 4. Search for the user you would like to merge to. Search by E-mail, First Name, Last Name, or 
Username and then click on “Search”. 

 

 
Step 5. Your second user should then be listed. Click on the radio button next to your user, then click on the 
“Merge Users” button. 
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Step 6. A confirmation will appear. Click on “Confirm Merge” to confirm, and click on “Cancel” to cancel. 
The merge is irreversible, so be sure to check the confirmation page carefully. 

 

 

Step 7. A completion page will display. It will show that user 1’s records were successfully merged to user 
2’s records. 
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Enrolling and Managing Users in a Course 
Overview: 
This section contains instructions on how to enroll and unenroll users, mark signups as attended or 
unattended, extend a user’s enrollment, mark users completed for course objects, set up a confirmation e-
mail per course, and send mass e-mails to enrolled users. 

1. Bulk Operations 
Through bulk operations, you can cancel signups, edit enrollments, or mark signup attended/not attended to 
multiple users.   
Step 1. Go to the course and click on the “Enrollments” link. 

 

Step 2. Select the users by checking the checkboxes next to their names. 

 

Step 3. Select an action from the dropdown and click “Execute”. If you choose Cancel signup, all data 
associated with that user's participation in the course will be removed. 

 

2. Exporting Enrollments 
Step 1. Go to the course and click on the “Enrollments” link. 

 

Step 2. At the bottom of the enrollments list, you will see a CSV icon. You can download a report of the 

users enrolled in each course.  
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3. Edit Enrollment and Completions 
Step 1. After checking the checkbox next to your user, choose the “Edit enrollment and completions” option 
from the Bulk Operations dropdown. Click on “Execute”. 

 

Step 2. You may set the date to extend the user’s enrollment, and set the enrollment status to active or 
inactive. Setting a user to be inactive will restrict that user from the course, but not unenroll the user. All 
the user’s data will be retained. 

Changing the completion status will change a user's course completion. Set to incomplete this to re-evaluate 
all requirements. Course will never be automatically un-completed once they have been marked completed. 

 

Step 3. Click on the “Set completion status” bar to see the course objects that can be set to completed. 

         
In this example, Quiz 1 is the Quiz object of the course, and you can set the user’s completion status for 
that specific course object.  
Complete - The user has completed and passed the course object. 
Incomplete - The user has not finished the course object. 
Failed - The user has failed the course object. 

Step 4. Click “Next” and then “Confirm”. 
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4. Enrolling a User into a Course 
Step 1. To enroll the user into a course, go to the course and click on the “Enrollments” link. Then click on 
the “Search and Enroll” link. 

 

Step 2. To narrow down your search, type in the user’s Username, Full Name, or E-mail Address and click 
“Apply”. 

 

Step 3. Check the checkbox next to the user’s name and click on the button “Enroll user in current course”. 
Then click “Confirm”. 

 

Please see Part 1 for unenrolling/canceling enrollments. 

5. Settings – Confirmation E-mail and Wait List 
In the Settings section of Enrollments, you can set confirmation e-mails for enrollments, a reminder e-mail 
for live courses, a signup limit, and manage the wait list. 

Step 1. Go to the course and click on the “Enrollments” link. Then click on the “Settings” link. 

 

Step 2. Fill in the confirmation message and put in place tokens to pull specific information. Click on 
“Replacement tokens”, and insert the tokens you would like to use.  
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Step 3. If your course is live, you will see the Reminder E-mail field. You may set this per course to send a 
reminder to your enrolled users. 

 
 

Step 4. You may set a limit of your total signups. By default, there would be no wait list once the limit is 
reached. 

 

Step 5. To add a wait list, choose the ‘Separate limits for each signup status’ option under Signup Limit 
Type. Beneath the Limit column, you can set the ‘Confirmed’ number(limit for signups) as well as the ‘Wait 
listed’ number(limit for how many users can be wait listed). 0 represents unlimited signups. You may see the 
Confirmed and Waitlisted limits and totals on the ‘Enrollments’ page as well. 
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Step 6. If a spot opens up for signups, you may broadcast an e-mail to all waitlisted users by going to the 
‘Enrollments’ tab, ‘Signup Broadcast’, enter in your e-mail message, and then choose ‘Wait List’ from the 
‘Limit Recipients’ field. 

 
Step 7. Click on “Save configuration” when finished. 

6. Signup Broadcast – Mass E-mails 
Step 1. To send out mass e-mails to users enrolled into a particular course, go to the course and click on the 
“Enrollments” link. Then click on the “Signup broadcast” link. 

  

Step 2. Type in the e-mail message and include tokens if needed. Click on “Replacement tokens,” copy the 
token you would like to use under the ‘node tokens’ column, and paste them in the message field. 
 

Step 3. Choose an option in the ‘Limit Recipients’ field to send an e-mail to a specific set of users based on 
signup status. 

 

 
Step 4. Click on “Send” when finished. You can also check the option to send yourself a copy. 
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Managing Learning Certificates 
Overview: 
This section contains instructions for adding, edit certificates and assign them to courses and users. 

Important things to know: 
Certificate settings are global, but can be overridden at the group or course level. 

1. Overview of Certificates 
If you need it, you can have a different certificate for each “type” of user on your site. The types of users 
are defined using a field in the user profile. For example, if doctors receive different certificates than 
nurses, you might use the degree field to map MD to the doctor’s certificate and BSN to the nurse’s 
certificate. 

However, if for one particular course you wanted all users to get the same certificate, you would map both 
fields to the desired certificate.  

2. Certificate Snapshots  
Once a user’s certificate has been generated, it is saved in the database and “locked” so that changes to the 
templates will not change the generated certificate. This ensures that the learners will always have same 
certificate saved even if it is inadvertently changes.  If you need to change users’ certificates after they 
have been generated, you may clear the certificate snapshots. 

3. Clearing Certificate Snapshots 
Step 1. In the admin menu, click “EthosCE Admin,” then “Certificate Settings”. 
Click on the checkbox next to “Use certificate snapshots?” 

 

Step 2. Once certificate snapshots are created, you can click on the ‘Clear’ tab to choose the course and 
clear snapshots. 
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4. Creating a New Certificate Template 

 
Step 1. In the admin menu, click “EthosCE Admin,” then “Certificate Settings”. 

 
 

Step 2. Click on the New Template tab. 

 

 
Step 3. Select a title, orientation, and design your certificate. Use the editor to enter text and image. 

Step 4. Upload an image. 

You only need this step if you would like  

to have an image in your certificate. 

Click the image icon in your text editor.  

Note: Your text editor may have a different appearance. If so, skip to the alternate method shown below. 

 
 
 
 
 
 



 Certificates 
 

  Version 3.3 – November 2013                                                                                              Page 38 of 110 

 
When the popup appears, click “Browse server.” 

 
 
 
 

 

 

 

 

 

 

 

 

When the new pop-up window appears, click, “Upload to server.” 

 

 

When the pop-up appears, click “Choose File.”  

Select a file to upload and click upload. When the upload is 
complete, close the small popup (shown immediately above). 
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Select the file you uploaded and click “Insert file.” 

 

Click “OK”. 
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Step 4. Enter token placeholders for course and user data. 
A token is a placeholder that will be replaced with actual course and user data when the certificate is 
generated.  

Step 5. Click “Save” when you are finished designing the certificate. 

5. Certificate Field Mapping Globally 
This section contains instructions on how to map your certificate template to a user profile field. You can 
override global settings in any course or group. 

Step 1. In the admin menu, click “EthosCE Admin,” then “Certificate Settings”. 

 

 
Step 2. Click on the Mapping tab. 

 

Step 3. Map the certificate template to the desired field and click “Submit.” 
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6. Mapping a Multi-Select Field  
Mapping a multi-select field is necessary if you are mapping a field that allows the user to select multiple 
values (for example, degrees) to a single certificate type. Before beginning this guide, ensure you have 
selected a profile field in Section 5, Step 3. 

Step 1. In the admin menu, click “EthosCE Admin,” then “Certificate Settings”. 

 

Step 2. Click on the Mapping tab. 
 

 
 
Step 3. Click on “Field groups”. 

 

 

Step 4. Select the check box next to Group Fields and 
click “Submit”. If there are no existing groups, click 
“Add a new group?” 

 
 
 

Step 5. Type in a Name of Field Group and click “Create”. 
In our example, we named our field group ‘Example’. 
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Step 6. Your group should show up, with a list of what you could map to 
your certificate type. In our example, we are mapping the degrees we want 
in our Example group. 

 
 

 

 

Step 6. To select multiple fields, hold down the CTRL or Control key on 
your keyboard and select the fields you would like to map. Then click 
“Submit”. To delete the group permanently, click the “Delete” link below 
the group. 

 

Step 7. Go to the Field Mapping tab and click on “Mapping”.                   

  
 
Step 8. Map the group to a certificate template and click 
“Submit.” This will allow multiple degrees to be mapped to a 
single certificate type. 

 
 
 
 

7. Overriding Certificate Field Mappings  
This section contains instructions on how to map your certificate template to a user profile field in a course. 
This overrides the global setting described above. 

 
Step 1. Navigate to the course you would like to give the custom mapping. Click “Edit.” 

 
Step 2. Map the certificate template to the desired field and click “Save.” 
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In this case, a user classified as “Physician” will receive the certificate specified in the global mapping, set 
in items 6 or 7. The “Non-physician” will receive “Sample certificate”. 

Depending on your version of EthosCE, you may not see a link in the left nav bar for certificate template 
settings. In that case they will be on the initial page you see when editing the course. 

8. Managing Certificates 
Step 1. In the admin menu, click “EthosCE Admin,” then “Certificate Settings”. 

 

Step 2. Click on the Templates tab. 
 

 
 
Step 3. You can edit, delete, or preview certificates by clicking on the links illustrated below. Note that 
completing a course as a test user would be best for a certificate preview. 
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9. Creating Certificate Criteria  
This section contains instructions on how you can map a special set of rules to a certificate. For example, 
you could give a course type its own certificate. This functionality is under active development at the time 
of this writing (Fall 2010) and the interface shown below may have changed. If your site was release prior to 
then, it may not be present. 

Prerequisites: 
You will also need to have a certificate template already created. You will use it to map criteria to the 
certificate. 

You will also need to know the criteria you want to use. In the example below, we are using a learning 
course type as the criteria. 

 

Step 1. In the admin menu, click “EthosCE Admin,” then “Certificate Settings”. 

 

 
Step 2. On the page that loads, in the top tabs, click “Criteria Sets”. 
 

 

 
Step 3. Then click “New set.” 
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Step 4. Give the criteria set a name and select a certificate template. In this example I have select the 
“Sample Certificate.” Click “Save.” 

Step 5. Click the middle icon to edit criteria. 

 
 
Step 6. Set the criteria type, criteria and value. In the example below, the criteria type is “Node,” and I 
have mapped the “Course” node type field, “Course Type” to the value “Fall 2010 Conference.” So any 
course type of “Fall 2010 Conference” will get this certificate. 
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Credit Types and Eligibility 
Overview: 
This section contains instructions on how to manage and map eligibility for credit types for your site. These 
are all global, site-wide settings, however some can be overridden at the course level. 

1. Managing Credit Types 
 
Step 1. In the admin menu, click “EthosCE Admin,” then “Course Settings”. 

 

 
Step 2. Click on the “Credit” tab towards the top right of the page. 

 
 

Step 3. Click on the “Credit Types” tab. 

 

 

Step 4. The default credit type will display. Click on the title of the credit to see the details. You may 
change the minimum and maximum credits, and the increments of credit (if variable credit is selected) and 
the option to “claim” credit. Click “Save Changes” when finished. 

Setting the option to claim credit allows the user to claim a variable amount of credit. 
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2. Mapping Credit Eligibility 
Step 1. On the credit type page, where it lists your credit type, click on “Edit” under Map. 

 
 
Step 2. Make your selections and click on “Set Mapping”. Users meeting all selected criteria will be able to 
receive credit for this type. 
Depending on your site configuration, you may be able to select: 
Certificate Group (for example Physician and non Physician) 
Profile Data (State License, Degrees, Special Interest, etc) 

3. Skipping Credit Claiming  
You have the option to set the credit claiming so that the credit claiming page will skip completely if user is 
not eligible to claim credits. 
 

Step 1. In the top right corner, select the Credit tab, and then on “Settings”. 

 

 

Step 2. Check or Uncheck this option to skip the credit claiming screen. Unchecking this option will result in 
the credit claiming screen displaying before the certificate is awarded, for all users at all times, even if they 
are not eligible to claim variable credit. 
 
Checking the option will only show the credit claiming screen to those users who are eligible for a credit 
type with variable credit claiming enabled. 

 

 

Step 3. Click on “Save Configuration” when finished configuring settings as desired. 
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4. Fallback Credit (For users with no credit eligibility) 
If a user does not have eligibility for any credit type, you can set a fallback credit type. The user will then 
receive that specified credit type. 

Step 1. In the top right corner, select the Credit tab, and then on “Settings”. 

 

Step 2. Select the type of credit you would like to award as a fallback. 

 

5. Skipping All Credit Eligibility Checks 
You can skip all credit eligibility checks. 

Step 1. In the top right corner, select the Credit tab, and then on “Settings”. 

 

Step 2. Check the box that says skip eligibility checks. 
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Creating a Live or Enduring Course 
Overview: 
This section contains instructions for how to create a course. 

Important things to know: 
Courses can be created inside a learning group, or outside of a learning group. Once a course is created 
within a learning group, it can not be moved to another group. 

1. Wizard and Expert Modes 
 
Step 1. To create a course within a learning group, navigate to your Learning Group page and click on 
“Create Course” in the side navigation.  

 

To create a course outside of a learning group, go to the Admin menu, click “Create Content,” and the 
“Course”. 

 
 

Step 2. The course creation mode is set to be a wizard setup by default. This wizard will guide you through 
each tab and section until the course is ready for publishing. 

 
The progress bar will show you where you are in the course creation process. Once each section is complete, 
the progress bar will be 100% green. You may then access a previous section by clicking on the section title 
in the progress bar. 
 
If you are already familiar with the course creation process and would like to use the Expert mode, click on 
the “Expert” button at the top right of the screen to turn it “On”. Expert mode will remove the progress bar 
and allow you to click on any tab. 
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Step 3. Complete the required information and go to the next tab of each section by clicking on the tab, or 
clicking on the “Next tab” button at the bottom of the page. You can access previous tabs by clicking on the 
tab itself, or clicking on the “Previous tab” button. 
 

 
 
 
Step 4. When you are finished the tabs of a section (in Wizard mode), you will see a “Next Section” button 
on the last tab. 

 
 
Step 5. When you are on the first tab of a new section, you will see the “Previous Section” button. 
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2. Course Description section 
Fill in required fields in each tab. The Course Description section has basic course fields that display on your 
course landing page. 
 
Title & Description tab: Enter in basic information for your course like the Title, Description. The 
description field supports HTML, but you must switch to full HTML mode to take advantage. To do so, click 
“Full HTML” at the bottom left of the description field. 
 

 

• It is recommended to use a Text Editor like Wordpad, Notepad, or TextEdit for pasting content (like 
Program Description) into the site. If your content is in a Microsoft Word document, there is 
additional formatting that may not translate well when rendered in your course. 
 
You should copy the content from Word, paste in the text editor, copy the content, and then paste 
into the field on the site. 
 
If necessary, in the text editor, you may need to change the format from Rich text to Plain text (to 
strip out formatting), then copy the content, and then paste into the field on the site. 

• You may edit your content in the Program Description field and use the editor to further format and 
stylize your content. 

 

 

Time & Place tab: Set the availability of your course. Users will not be able to enroll in the course before 
the release date or after the expiration date. 
 
To make a course Live, go to the Time & Place tab and check off the “Live Event” checkbox. More fields will 
drop down to fill in the dates and location. 
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If your course is a live event, users will not be able to enroll after the event has passed. 

 

Faculty & Disclosure tab: Enter in Faculty & Credentials, as well as a link to Disclosures.  
 
Course Format & Instructions tab: Select your course format and type in course instructions. Course 
Instructions will appear when the user goes to take the course, above the course workflow. 
 
Prerequisites tab: You may set one or more courses as a prerequisite for enrollment. You must have courses 
already created to enter them as prerequisites.  
 
Type in your Course prerequisites and re-order by dragging and dropping with the draggable tool. The order 
is only used for showing the user the list of prerequisites - the order is not enforced when enrolling in the 
prerequisites. Click on “Add another item” to add more prerequisites.  

 
You may also enter in your Required Hardware/Software on this tab. 
 
ACCME tab: If ACCME is enabled on your site, this tab will appear. ACCME stands for the Accreditation 
Council for Continuing Medical Education. ACCME information will need to be filled in in order for courses to 
be reported to PARS. 

• AMA Learning format – select the appropriate learning format from the drop down list. 

• Enable ACCME is checked by default.  You may uncheck to disable if you do not need the course to 
be reported to PARS. 

• Enter the total hours of instruction into the Hours of Instruction field. 

• Enter the provider activity ID number into the Provider Activity ID field. 
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• Direct Sponsor is default for Sponsorship.  If the course is a joint sponsor, click Joint and enter the 
name of the joint sponsor. 

         

• Choose an Activity Type from the dropdown list. ‘Enduring Material’ should be selected for an 
enduring course. 

• At the end of the course when the reconciled budget is submitted, that information goes into the 
Income and Expense fields. 

  

Support tab: When there is commercial support, click on the ‘Yes’ checkbox. A new section will be visible: 

 
 

• Select the month of the meeting under the ‘Month’ dropdown list and enter the year of the meeting 
in the ‘Reporting Year’ field. 
 

• Select the name of the company in the ‘Support Source’ dropdown field and enter the amount in the 
‘Amount Received’ field. 
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• If there are multiple commercial supporters, click on the ‘Add another item’ button to add each 
supporter. 

• In the event of in kind support, click the appropriate box. 

3. Course Settings section 
Fill in required fields in each tab. 
 
Course Settings tab:  

• Check off “Attendance Required” if you want to restrict the learner 
from receiving a certificate or credit until they are marked attended. 
 

• The Enrollment Duration field is the length in days a user can remain in 
the course. Enter 0 for unlimited.  
 

• Custom outline titles will allow you to name a course object using a 
custom name rather than the system defaults. (Creating course objects 
happens in the next section of this manual.) 
 

• Pass/Fail should be enabled if you do not want to student to complete 
the course unless you manually set the Pass/Fail for the user. Please 
refer to the “Enrolling & Managing Users in a Course” section of the 
manual for manually setting the completion status per user.  

 

 

Course Credit Settings tab: 
Note - Credit types in examples may be different from your site. 
 
Click on the plus symbol (+)  next to the credit to have the settings appear.  You may change the minimum 
and maximum credits, and the increments of credit (if variable credit is selected). To make the credit type 
active, check on the “Active” checkbox if it is not checked already.  
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The Expiration Type dropdown fields are options for credit expiration: 

 

 
• None - Credit does not expire. 

 
• Specify Date - Credit will expire on the exact date set. 

 
• End of year credit awarded - Credit will expire at the end of the year in which the user completed 

the course. 
 
Example: If user completed a course on November 14th, 2012, the credit will expire December 31st, 
2012 
 
The offset field is for setting the credit expiration to happen the specified number of days after the 
end of that calendar year. 
 
Example: If user completed a course on November 14th, 2012, the end of the calendar year is 
December 31st, 2012. If the offset is set to 30, the credit will expire 30 days after December 31st, 
which is January 30th, 2013 
 

• Date credit is awarded - Credit will expire at the specified number of days after credit has been 
awarded. 
 
Example: If user completed a course on November 14th, 2012 and the offset is 10, the credit will 
expire November 24th, 2012. 

Expired credit will not appear in a learner’s transcript. 

Certificate Template Settings tab: You may set the certificate template per course. This will override the 
global defaults. 

Signup Settings tab: If you would like users to be able to sign up to 
the course from the site registration form, check off the “Users can 
sign up for this event from the user registration form” box. 
 
Restrict signups to certain roles: You may check off the role(s) that 
you would like the course to be restricted to. Only users with that role 
will be able to enroll. 
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Course Requirements tab: Enter an access code if you wish to restrict this course by use of a password. 

  

Reminders tab: When creating a course, you can create reminders for your users. Reminders will send 
emails to users before or after a certain point in the course workflow, at a time you specify. You may have 
more than one reminder per course.  
 
Reminder options are shown in the screenshot below. As you add course objects, they will also appear in this 
list as Completion or Inactivity options. 
 
There are various types of reminders, which will trigger when certain conditions are met. For instance, an 
“Inactivity Reminder” will trigger when the user becomes inactive at a certain course object. 
 

 
 
Check the “Enabled” checkbox to enable the reminder. Use the “commonly-used tokens” list to 
automatically insert user information into the message field. Check the ‘Send test’ checkbox to send your 
admin user a test e-mail. 

 
To have a reminder send repeatedly, check the ‘Repeat’ checkbox and set how often you would like your 
reminder to repeat, as well as how long you would like your reminder to continue to repeat. 
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4. Pricing Information 
You can set role-based pricing under the “Product Information” tab. The Default Sell price is the non-
member price, and the Member Price is where you enter the member price. You can leave the member price 
empty if there is no member price. 

 

5. Publishing section 

• Menu Settings tab: Add your course to the menu by giving your course a Menu Link Title. You can 
sort the menu item in Parent Item dropdown, or by weight. 
 

• Revision Information tab: Enable revisions if you would like revisions to be saved every time you 
make a change to the course. You can revert back to a revision if need be. 
 

• Authoring Information tab: Enter in the author of the course, and on what date the course was 
create. These fields pre-populate with information, but you may change the information.  
 

• Publishing Options tab: Check the “Published” checkbox if you would like the course to be 
published. Uncheck if you would like the course to be unpublished. Users will not be able to access 
the course if it is unpublished. 
 

• URL Path Settings tab: Change the URL path setting, if you would like to change the automatic alias 
that is populated from the course title. 
 

• Comment Settings tab: By default, comments are disabled, but you can enable them so that users 
will be able to comment on the course landing page. 

• Groups tab: By changing the Audience field, you can move your course into a group by selecting an 
existing group in the dropdown, or remove a course from a group by selecting ‘No Group’. This will 
move the course and its objects to where you designate! 
 

Note: In standard EthosCE, only Site Admins and Course 
Admins can move courses between groups.  
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6. Saving Course 
At any given time, you can save your course by clicking on the “Save” button at the bottom of the 

sections.  
After you have finished entering all the information, your course will be ready to have course objects added 
to it. 

7. Cloning Course 

To clone a course, navigate to the course you wish to clone and click the “Clone” tab.  
The cloned course may now be edited if any changes need to be made. Course settings will automatically 
cross over and may be edited also. 

8. Expired courses 
Expired courses will not be automatically unpublished. However, users will no longer be able to complete 
them. For this reason, you should unpublish expired courses if you don’t want them to be publicly visible. 
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Creating Course Objects 
Overview: 
This section contains instructions on how to create course objects for your course. You will be working 
mostly on the “Course Objects” page. From this page you will add different elements to your course that the 
learner will complete to earn credit.   
 
A typical workflow for a course is: CME Info, Pre-quiz, Course, Post-quiz, Evaluation, Certificate. 
 

1. Course Objects 
 
Step 1. Navigate to the course you would like to add your course objects to, and click on the “Course 
objects” tab. 

 

 
Step 2. To add objects to your course, click on the “Add” button next to the object you would like to add.  

Step 3. After filling the required information and saving, the object will then move over from the “Actions” 
column to the “Existing Activities” column. 
 

 

Step 4. You may then edit ( ) or delete  ( ) the object. 
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At the bottom of the page, you will see a preview panel of the course objects. This represents the learner 
view of the course workflow.  The custom outline titles will appear if you enabled “Use custom outline 
titles” when creating your course shell (under Course Settings section and tab). Otherwise, the default titles 
will display. 
 

 
 
Course Objects reflect if the object is Optional (learner may skip), Required(learner cannot skip), Completed 
(green checkmark), or Locked(will be unlocked when user completes required objects). You can set the 
requirements through the Certificate Requirements tab of your course. 

2. Creating CME Info 
Step 1. Click “Add CME Info” under “Actions” to add it to your course. The CME Info can be a description or 
an introductory to your course. 

  

Step 2. Add a “Name” to your CME Info. A “Name” is required. If you have custom titles turned on, the 
name of the CME Info object will display to the learner. 

 
Step 3. Add a body of text to your CME Info. The CME Info’s full text will be shown to the user before they 
see any course content, so its good to include information such as: Educational Objectives, Accreditation 
statement, Faculty Information, Fees, Commercial Support, Unlabeled Use Disclosure. 
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Step 4. Click “Save and return to course” (towards the bottom of the page) to go back to adding, editing, or 
deleting other course objects. Click “Save and display” to view your CME Info section. 

3. Creating a Quiz 
Step 1. Click "Add Quiz" under "Actions" to add it to your course. 

 

 
Step 2. Type in your Quiz title. 

 

Step 3. Configure settings as desired and click on the ? icons for additional help. It is important to have the 
“Adaptive Mode” set to “No” under “Attempts” unless you want your learners to be able to attempt 
questions more than once in a single quiz. 
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Step 4. For a Pre-test, you may want to leave the Review options as unchecked so that the user does not see 
a score or responses once they complete the Pre-Test. For a Post-Test, you may want Review options 
enabled. 

 
 
 

Step  5. Click “Save and return to course” towards the bottom of the page. Clicking “Save and Display” will 
take you to the Question bank – please see the Question Management section for adding questions. 

Step 6. To set your quiz to be a Pre-Test or Post-test, and to set a Passing Grade for your quiz, please see 
the Setting Certificate Requirements section of the manual. 
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4. Creating a Course Object 
There are multiple course objects that we will discuss in sub-sections below. 

Adding HTML Course to a course: 
 

Step 1. Click “Add HTML Course” under "Actions" to add it to your course. 

 
 
Step 2. Enter the Name, Summary, and Full text into their respective fields. Name and Full text is required. 

If you would like to show/hide content based on mobile devices versus desktop viewing, you can add specific 

class tags to your content. Click on this icon in the WYSIWYG editor:  You will then be in TEXT/HTML 
mode. You can add classes to your content for mobile only or desktop only viewing, for example: 

<span class="mobile-only"> MOBILE CONTENT GOES HERE </span> 
<span class="desktop-only"> DESKTOP CONTENT GOES HERE </span> 

NOTE: This functionality will only work for the “Full Text” section of the course. 

Step 3. Click “Save and return to course” towards the bottom of the page. The item “HTML Course” should 
appear in the “Existing Activities” column in the course settings page. 

 

Adding Link to file or website to a course: 
 
Step 1. Click “Add Link to a file or web site” under "Actions" to add it to your course. 

 
 
Step 2. Enter the Name, Summary, and Location (Web Address/URL) into their respective fields. 

 

 
 
Step 3. To pass data to an external website using the query string, if not already visible, in the 
“Parameters” section, click “Show Advanced”. Name and select the parameters to pass.  (*Note: to pass the 
student's UID from Drupal, select the “User - ID number” field value.) 
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Step 4. In the “Window” section, choose either “New Window” or “Same Window” to preference. 

 
 
Step 5. Click “Save and return to course”. The item “Link to a file or web site” should appear in the 
“Existing Activities” column in the course settings page.   

 
 
Adding List of files 
If you would like to display a list of files from the server for the user’s view (a list of PDFs, for example), this 
would be the course object to use. 

Step 1. Click “Add List of files” under "Actions" to add it to your course. 

 

Step 2. Enter the Name and Summary into their respective fields. Then click on “Save and display”. 

Step 3. If you would like to edit or add files, click on the “Edit Files” button. 

 

Step 4. Upload files by clicking on “Upload a File” and then “Browse Server” 

 

Step 5. Click on the “Course Settings” tab when finished. The item “List of files” should appear in the 
“Existing Activities” column in the course settings page.   
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Adding a Camtasia Package or multi-file presentation package to a course: 

Step 1. Click “Add Link to a file or web site” under "Actions" to add it to your course. 

 

Step 2. Scroll down to the Link to a file or website section and click on the “Choose or upload a file” button. 

 

Step 3. Click on “Upload a file” 

 

Step 4. Click on “Browse” or “Choose File” and choose your Camtasia or webcast package in .zip format. 
Then click on “Upload this file”. 

 

Step 5. Once the package uploads, click ‘Unzip’ to unzip the files. 

 

Step 6. A list of files will appear and you can click “OK” to continue. Click on “Choose” that is on the same 

row as the .html file listed. The html file is the file that needs to be linked the course. 

Step 7. The Location will pre-fill with the html file’s name. Click on “Save and display” to save. 
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Adding Talkpoint Session to a course: (requires third-party account with Talkpoint) 
 
Step 1. Click “Add Talkpoint Session” under "Actions" to add it to your course. 

 
 

Step 2. Enter the Name, Summary and ID number of the Talkpoint Session into their respective fields.  

Step 3. Click “Save and return to course”. The item “Talkpoint Session” should appear in the “Existing 
Activities” column in the course settings page. 

 

Adding a SCORM/AICC to a course: 
 

Step 1. Click “Add SCORM/AICC” to add it to your course. 

 
 
Step 2. Enter the Name and Summary into their respective fields. 

Step 3. Click on the “Choose or upload a file”. 

 
 
Step 3. Click on “Upload a file” 

 

Step 4. Click on “Browse” and browse for the SCORM package on your computer. The SCORM package should 
be in .ZIP format. Click on “Upload this file”. 

 

Step 5. Once the package uploads, click ‘Choose’. 
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Step 6. Click “Save and return to course”. The item “SCORM/AICC” should appear in the “Existing Activities” 
column in the course settings page.   

5. Creating an Evaluation – Default or Follow-up 
Step 1. Click “Add Evaluation” to add it to your course. 

 
 
Step 2. Enter the Name and Summary into their respective fields. Select a survey type, either “default” to 
present during course, or “follow-up” for afterwards. If “follow-up” is selected, choose the number of days 
after the completion of the course that the evaluation will be presented by selecting from the “Notify Days” 
field.  

                 

 

Note: For follow-up survey, you can set the e-mail notification message by going to the Admin Menu, click 
on “Administer,” “Site Configuration,” and then “Course”. You will see a field where you can enter in the 
notification message and tokens. Users will be notified with this message by e-mail once the follow-up 
evaluation is open to them. 
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Step 3. Configure settings as desired.  

 
Step 4. Click “Save and return to course”. The item “Evaluation” or “Follow-up Evaluation” should appear in 
the “Existing Activities” column in the course settings page, depending on which option was selected.  
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Question Management 
Overview: 
This section contains instructions on how to manage questions once you have created a quiz or evaluation 
object. For quizzes, you have the ability to import questions. 

1. Adding Quiz Questions 
 
Step 1. Once you have created your quiz object (see section 3 under the Course Objects section), go under 

“Existing Activities” where your Quiz is listed, and click the small paper and pencil icon:    

 

 
 
Step 2.  Scroll down to the bottom of the page and click the “Save and Display’ button. 

 
Step 3.  To the right side, under the “Question Bank” section, go to “Create new Question”. You can select 
your question type. We will be showing you how to add a Multiple Choice question with choices. 

 
 

Step 4.  Selecting your question type should automatically direct you to where you will add your question 
and answers. Enter the Name of your Question. In the text field under “Question text,” input your question. 
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Step 5.  Configure settings as desired. Click the  icons for more help. 

Step 6. On this page, you can also enter answer choices, if appropriate. In the following example, since the 
question type is multiple choice, we can add them. Choice 1 will be the first multiple choice answer. If you 
want an answer to be correct for the quiz, you can do this by setting the grade for the answer as 100%. 
Choices with grades of “None” are incorrect answers for the quiz. “General feedback” is text that will show 
up once the corresponding answer is selected. 

 
 
 
Step 7. You can leave a general response for a correct or incorrect answer. 
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Step 8. Click “Save Changes”.  

 
Step 9. Your question name should appear under the “Create New Question” section. You can edit your 

question and choices by clicking on the small hand and pencil icon:  You can delete your question by 

clicking on the X icon:  

 
 
 

Step 10. To add the question to your quiz, click the left arrows:  or click the “Add to quiz” button. If you 
have multiple questions, the check box for each question you wish to add to the quiz must be selected 
before they are added. 

 

Step 11. Once you click:  or the “Add to quiz” button, your question will appear under “Questions in this 
quiz”.  
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Step 12. To preview your quiz, click the “Preview” tab. You can click the “Edit” tab or the  icon to edit 
your question. 

 
 
Step 13. Repeat steps 3 - 12 to add more questions. 

2. Importing multiple choice quiz questions to a quiz 
(pre or post test) 
Step 1. You will need to create a txt file – .txts can be created in a program like Text Edit, Notepad, or 
Wordpad , but the format has to be plain text.  You will need to save the file as Unicode (UTF-8). 

Step 2. In the .txt file, type in the questions, choices, and answers like so: 
 
What is the correct answer to this question? 
A. Is it this one? 
B. Maybe this answer? 
C. Possibly this one?  
D. Must be this one! 
ANSWER: D 
 
Which LMS has the most quiz import formats? 
A) Moodle 
B) ATutor 
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C) Claroline 
ANSWER: A 
 
Be sure to follow that exact format (capitalized letters when need be, questions on one line, etc) 

Step 3. Once you have your .txt file ready with all of your quiz questions and answers, you can move on and 
create your quiz through the course settings (Follow steps in 3. Creating a Quiz). Click “Save and Display” 
when finished with creating the initial quiz. 

Step 4. Click on the “Import” link located under the tabs. 

 

Step 5. Select “Aiken” as your file format. 

 

Step 6. Under the Import from file upload section, browse and upload your .txt file that you created in steps 
1 and 2. 

Step 7. Click on the “Upload this File” button. Your questions should show in the question bank where you 
then can add them to your quiz. 

3. Adding Evaluation Questions 
Step 1. Once you have created your evaluation object (see section 5 under the Course Objects section), go 

under “Existing Activities” where your Evaluation is listed, and click the small paper and pencil icon:   

  
 

Step 2.  Scroll down to the bottom of the page and click the “Save and Display’ button. 

Step 3.  Click “Questions”. 
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Step 4.  Select your question type and click the “Add selected question type” button. We will use radio 
buttons (for a multiple choice question) in this example. 

 
 

Step 5.  Enter the Question Name and Question Text. The Question Text is the actual question. 

 
 

Step 6.  Enter your possible answers. Each answer has to be on its own line. Then click “Save Changes”. 

 
 

Step 7.  Your question will show up under the “Questions” section. You can edit your question and choices 

by clicking on the small hand and pencil icon:  You can delete your question by clicking on the X icon:  
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Step 8.  You can click “Preview” to preview your evaluation question. Click “Questions” to add, edit, or 
delete questions. 

 

 
Step 9.  Repeat steps 3 - 8 to add more evaluation questions. 

How to create an evaluation template 
An evaluation template is useful because you may want to use the same evaluation questions when you have 
multiple courses. To create a template, an unpublished or “place holder” course should be built first. Follow 
“How to Create a Live or Enduring Course” section to build a course. 

 
Step 1. Once you have created your evaluation object and have added your questions to your unpublished 
course, go under “Existing Activities” where your Evaluation is listed, and click the small paper and pencil 

icon:   

  
 
Step 2.  Scroll down to the bottom of the page and click the “Save and Display’ button. 

Step 3.  Click on “Advanced Settings” and change the Questionnaire Type to “Template”. The “Template” 
option can be copied and edited. This type of questionnaire cannot be used directly, but its content can be 
copied into a new questionnaire and edited. Adding a Title would be useful. 
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Step 4. Click “Save Settings” towards the bottom of the page. 
 
Step 5. Now it’s time to add an evaluation to your public/published course. Follow the steps to add an 
evaluation object (see section 5 under the Course Objects section), but when you get to the “Content 
Options” section, next to “Copy Existing,” you can choose the template that you created in your unpublished 
course. 

 
 
Step 6. Click “Save and Display”. 

 
Step 7. Click on “Advanced Settings” and make sure the Questionnaire Type is set to “Private”. The 
“Private” option belongs to the course it is defined in only. You create a questionnaire and its questionnaire 
content for the course it is defined in. Editing teachers of that course can change the questionnaire and all 
teachers can review the results.  

 
 
 
 

 

Step 8. Click “Save Settings” towards the bottom of the page. 

Step 9. Preview your evaluation by clicking “Preview”. Your evaluation should contain the same questions 
that you created with your unpublished course. 

 
 
Step 10. You can always edit your template by going through the unpublished course and changing the 
questions and answers in the evaluation.



 Commitment to Change  
 

  Version 3.3 – November 2013                                                                                              Page 77 of 110 

Commitment to Change 
Overview: 
This section contains instructions for how to add a “Commitment to Change” to your course. A Commitment to 
Change is a self-directed evaluation for reporting purposes and measuring outcomes.  
 
Within EthosCE, the CTC is configured is set at a global level, and then can be enabled at the course level. Only 
one CTC can be created at the global level. Once enabled at the course level, the CTC becomes a course object 
for the user. This course object is recommended to go before the user is able to claim credit or retrieve their 
certificate. 

1. Commitment to Change Forms and Workflow 
This section is where you setup the global CTC. 

 
Step 1. In the admin menu, go to “Administer,” “Site Building,” and then “Commitment to Change”. 

 

Step 2. Enter in your categories and barriers. Categories and barriers have to be entered in a specific way — 
as key-value pairs. See example in screenshot below. 

In the Reminders field, you can set options for what the learner can choose for their Commitment to Change 
Follow-up. This is configurable. The first key represents the number of days, and the 2nd value is the label 
that the learner will see. 
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 Each category will ask the following questions for the user: 
 1. List a specific, measurable change you plan to make 
 2. On a scale from 1 to 10, how confident are you that you will be able to make this change? 
The Barriers that you set will appear when the user selects ‘No’ as their answer to implementation.  

See the user workflow section (section 3 below) for more information about the workflow. 

Step 3. Save 
Upon save, you will see a default Commitment to Change field where you can choose which form to use by 
default unless otherwise specified in the course. 

2. Adding Commitment to Change to a Course 
When creating or editing your course, go to the Course Settings section and Course Settings tab. Check off 
“Include Commitment to Change” to enable. 

 

3. User Workflow 
Step 1. When a user takes their course, they will see the Commitment to Change icon in the course 
workflow. After clicking on the icon, they will see the Commitment to Change default form. 
 
Each category will ask the following questions for the user: 
 1. List a specific, measurable change you plan to make 
 2. On a scale from 1 to 10, how confident are you that you will be able to make this change? 
 
The user will then be able to set a time period for when they would like to receive a reminder for their 
commitment. 

Step 2. Once that time has passed, the user can revisit the Commitment to Change course object to 
“REFLECT and COMPLETE”. They can review their specific measurable change and confidence level. 

Step 3. Upon clicking the “REFLECT and COMPLETE” link, the user will be asked if they were able to 
implement their change.  

• If user selects ‘Yes’, they can type in their outcomes and complete the CTC.  

• Barriers will appear when the user selects ‘No’ as their answer to implementation. The user can 
check off their barriers and note their planned modifications.  

• If user selects ‘Still plan to implement the change but need more time to do it,’ a dropdown field 
with time periods will appear. The user can then choose a time. One the time is up, the user will 
receive a reminder to complete their CTC. 
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4. Commitment to Change – User Profile 
Users who have started a Commitment to Change can access their commitment by going to their profile and 
clicking on the “Commitment” tab. They can click on View/Update to access their Commitment. 

5. Commitment to Change Report 
Admins can view Commitment Reports by going to the “Course Reports” tab and clicking on “Commitment 
Overview” 
 

 
 
You can filter by date, see the completions, and average confidence level. 
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Setting Certificate Requirements 
Overview: 
This section contains instructions on how to set certificate requirements for your course. This is where you will set 
the order of your course objects, set objects to be required, set passing grades for quiz objects, and 
enable/disable objects. 
 

Step 1. When viewing your course, click the “Certificate requirements” tab. 

 
 
Step 2. Set a course object to be required by checking the ‘Required box’. If checked, the user will not be 
able to continue until that course object is complete. If un-checked, the object becomes Optional and the 
user may completely skip the object. 

 

 
Step 3. To disable a course object uncheck the ‘Enabled’ box. 

Step 4. For quizzes, you may set the Passing Grade in the ‘Passing Grade’ field and specify whether the quiz 
is graded or not. Although non-graded quizzes are scored, the learner's score is not used to evaluate the 
completion status of that quiz. You can also change the quiz to be Pre-test or Post-test under the ‘Info’ 
column. When having a Follow-up quiz, the quiz type should be set to 'None'. 
 
Step 5. The ‘follow-up’ checkbox allows you to set rules for when a quiz appears. You have the following 
options: 

• Days after awarding certificate 
• Days after completing post-test 
• Days after event 

Use the ‘follow-up value’ text box to enter the number of days after the selected option you would like the 
follow-up quiz to appear. 

Step 6. To change the order of course objects, drag the handles vertically.  

IMPORTANT: If you place any objects after the certificate, do not set them to be required. If they are 
required, the learner will not be able to earn their certificate. 
 
Step 7. Click Save to submit the form and save changes.
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Linking Activities  
Overview: 
Linked activities provide a way to group activities. Each group of linked activities consists of a parent and 
one or more child activities. Once grouped, additional features for those activities become available. You 
can: 

● Allow for a single certificate to be awarded after completing the required child activities or allow each 
child activity to have its own certificate  

○ If using a single certificate on the parent, enforce that the learner must complete the child 
activities in order or allow the learners to complete them in arbitrary order 

● Allow users to purchase all the child activities together, or individually or provide an option for either 
purchasing together or individually. 

● Allow users to receive a discount for purchasing the entire group. 

● Allow for users to purchase a parent and receive access to all existing and future child courses 

● Allow for users to complete a certain amount of courses (in any order) before receiving credit or 
certificate. 

● Allow users to claim immediate credit. 

● Allow for credit to be aggregated from children and activity sets. 
 

Important things to know: Relating courses to an activity set can change the course’s 
settings. It is recommended to publish and unpublish activity set parents and their related 
courses at one time. 
 

1. Create an Activity Set - Parent 

 
Step 1. In the admin menu, select “Create Content,” then “Activity set”. 

 

 
 
Step 2. Enter a Name for your Activity Set under the “Title & Description” tab. 
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Step 3. Give your activity set a start and expiration date under the “Time & Place” tab. You will want to set 
the expiration date to the latest expiration date of a linked child. To set a live event date, click on the ‘live 
event’ checkbox and input a date. Users will not be able to enroll after the start event date has passed. 

Any change to the enrollment expiration date at the activity set level will propagate down to the related 
child activity sets and courses. 

Step 4. Go to the “Course settings” tab to adjust your activity set’s settings. 

 
Catalog Display 

• Display parent only. This will display only parent courses 
in the catalog. 

• Display children only. This will display only children 
courses in the catalog. 

• Display parent and children as separate items. This will 
display parent and children courses as separate items in 
the catalog. 

• Do not display parent or children. This will not display 
parent or children courses in the catalog. 

 
Enrollment Options 

• Auto enroll all child courses. This will enroll a user into 
all the child activities when the user purchases the 
parent. You must select this field if allowing user to 
purchase the parent and the children. 

Activity Set Credit 

• Aggregated - When credit claim is on the parent, this 
option will aggregate min/max credit from completed 
children. 

 

Activity Set Children Bulk Add Behavior 

• Check status and send to completion - If the user selects all linked courses that have no 
requirements, this will send user to immediate credit claim after enrolling. This is useful for 
conference-like activities. 

Activity Set Completion Requirements - Requirements for a certificate and combined credit to be awarded. 
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• Specific - This allows the learner to take the child courses in any order. Courses marked as 
"Required" must be completed to receive credit if the parent is credited. 

• Sequential - User must complete all courses in order 
• Minimum - The specified minimum number of children must be completed 

 
Minimum Number of Completed Courses - Required minimum number of courses that must be finished to 
complete the parent. Only takes effect if Course Requirements is set to "Any" 

Ubercart settings  
 

• Learner may only purchase parent. Learners will not have an option to purchase the children. They 
will be included with the parent when the purchase is made. 

• Learning may only purchase children. Learners will not have the option to purchase the parent. 
• Learner may purchase parent or individual children. Learns will have the option to purchase 

either the parent or the children. If the parent is purchased, all the children will be included. 
 

Enrollment Duration -  The Enrollment Duration field is the length in days a user can remain in the activity 
set. Enter 0 for unlimited. When the Enrollment Duration field is set at the activity set level, the duration 
will cascade down to all child activity sets and courses. 
 
Step 5. Click “Save” at the bottom of the page. 

2. Create an Activity Set - Children 
Children may be existing courses, new courses, or other activity sets. 

Step 1. Create courses that will be your children courses. 

Step 2. Navigate to your parent course and click on the “Edit” tab. 

 

Step 3. Click on “Course Relationships”. Select your children. Enter the first few letters or words of the 
child course title and then select it from the dropdown list. Click “Add another item” to add more than 2 
children.  
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3. Course Relationships 
You may optionally set prerequisites for linked activities. You may set a requirement that a user must 
complete one activity before the linked activity becomes available.     
 
Step 1. When creating your parent activity set, go to Course Settings tab. make sure the Course 
Requirement is set to “Sequential”. 

 
 
Step 2. Type in your Course Pre-requisites under the Course Relationships tab. Click “Add another item” to 
add more pre-requisite courses. 
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Order Creation 
Overview: 
This section contains instructions for how to manually create an order. Courses, Activity Sets, and Products 
are considered as products in EthosCE. 

 

Step 1. In the admin menu, select “Administer,” then “Store Administration”. 

 

Step 2. Select “Orders” and then “Create Order”. 

 

1. Creating order for existing user 
Step 1. Click on “Search for existing customer.” 

 



 Variable Pricing  
 

  Version 3.3 – November 2013                                                                                              Page 86 of 110 

 

Step 2. Enter information in fields and click “Search button.” 

 

Step 3. From the search results, select a user and click the ‘Select’ button. On selecting the user, the ‘New 
Order customer’ section will get populated with the user information. 

 

Step 4. Click “Create Order.” 

Step 5. Enter the Billing and Shipping information for the user. You may use the buttons beside ‘Ship to:’ 
and ‘Bill to:’ labels to copy over the information into fields. Payment method may be selected from the 
Payment method select box. 
 
Step 6. To add a product(course) to the order, click on the “Add Product” button. You may search for the 
product by the product name or SKU. Select a product from the list and click the “Select” button. 
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Step 7. After the product is selected, click the “Add to order” button. Qty may remain as 1. 

Step 8. Repeat steps 6 & 7 to add more products to the order. 
 
Step 9. Discounts, if any, may also be added to the order by adding a Coupon discount line. Enter a negative 
amount to offer discounted price to the user. 

 

Step 10. Comments on the order may be added in the ‘Admin comments’ section. By default, the order 
created and stock level comments will be added to the order. 

Step 11.  Verify the order and click ‘Submit changes’ button 
 

2. Creating a new customer 
Step 1. Click on “Create a new customer.” 

 

Step 2. Enter the customer e-mail address, and check the ‘E-mail account details to customer’ checkbox if 
the customer has to be notified. Click ‘Submit’ button. 
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Step 3. New order customer section will be populated with the user details. 

Step 4. Repeat Steps 4 to 11 from the section ‘Create Order for existing user’ section of the user guide. 
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Variable Pricing 
Overview: 
This section contains instructions for how to add and manage variable pricing to a product. Variable pricing 
is used for setting prices and fees for products. 

 

1. Creating Attributes and Options 
 
Step 1.  As admin, edit the course by clicking the “Edit” tab on the course’s main page. 

 
 
Step 2.  Scroll down to Product information and set the Sell Price is $0.00. 

 
 
Step 3.  Scroll up and click on “Attributes”. 

 
 
Step 4.  If no Attributes are set, you must add them by clicking on “add attributes to this product”. 

 
 
Step 5.  Click on “here” to add Attributes. 

 
 

 



 Variable Pricing  
 

  Version 3.3 – November 2013                                                                                              Page 90 of 110 

Step 6.  Give your Attribute a name. Click “Submit” when finished. 

 
 

Step 7.  To add price options to your Attribute, click on “options” under 

Operations. 

  

Step 8.  Click on the “Add an option” tab if no option is listed. 

  
 

Step 9.  Give the option a name - this name will appear to customers on 

product add to cart forms. Set the Cost and Price of the Attribute. Click 
“Submit” when finished.  

 

 

Step 10.  Click on “Overview” to see your Attribute, with price and cost listed. 
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2. Managing and Using Attributes 
 
Step 1.  As course admin, edit the course by clicking the “Edit” tab on the course’s main page. 

 
 

Step 2.  Click on “Attributes”. 

 
 
Step 3.  If Attributes are already listed, select an Attribute and click on the “Add attributes” button. To add 
more Attributes than the ones listed, click on “here”. 

 
 

Step 4.  The Attribute you have chosen(Educational Fees in this example) will appear in a list. You may 

remove the Attribute, set it as required by clicking on the checkbox, and choose how you would like it to 
display. To have the variable pricing show up for users ready to purchase the course, click on the checkbox 
under Required. Click on the “Save changes” button to save. 

 

 

Step 5.  To edit the fees themselves, click the "Options" tab. 

 
 

You can then select/deselect the options you would like to display, set the default, and set the cost and 
price of each option. 
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Step 6.  Click on “View” in the navigation to view your course. You should see the Attribute info. 
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Coupons 
Overview: 
This section contains instructions for how to add and manage coupons. 

1. Creating Coupons 
Step 1. In the admin menu, select “Administer,” then “Store Administration”. 

 

 
 
Step 2. Select  “Coupons”. 

 
 
Step 3. To add a new coupon, click on “Add new coupon” in the admin menu, or on the Coupons page. 

 

 

Step 4. Enter a Coupon Name and Coupon Code. The Coupon Code is what users will use to receive their 
discount. Keep in mind that Coupon Codes cannot be changed once they have been used in an order. 
 
Check “Coupon is active” to enable the coupon. Uncheck to disable the coupon. 



 Coupons 
 

  Version 3.3 – November 2013                                                                                              Page 94 of 110 

 

 

 

Step 5. Enter the Discount. Three discount types are possible: 

• Fixed price discount; enter "15" for $15.00 off. 
• Percentage discount; enter "15%" for 15% off.  
• Set product price; enter "=15" to make all matching products $15.00 

after discount. 

Step 6. Configure settings as desired. 

Apply Discount to - The options that include ‘matching products’ coincide with the courses you list under 

the “Applicable products” section.  
 
Require all products to match- If checked, the coupon would 
be rejected if an order contains any non-applicable products - 
Applicable products are the courses you list under the 
“Applicable products” section. 
 
Restrict coupon by date- If checked, date fields will appear for 
setting the start and expiration dates of your coupon. Coupons 
will not be usable if the start date is in the future, or if the 
expiration date is in the past. 
 
Maximum Number of Redemptions (Per Code)- Enter the 
Maximum number of times each code for this coupon can be 
used, or 0 for unlimited. If set, the coupon can only be used 
this number of times. For bulk coupons, this applies to each 
available code. 
 
Maximum Number of Redemptions (Per User)- Enter the Maximum number of times this coupon can be used 
by a single user, or 0 for unlimited. 
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Step 7. Configure settings as desired by clicking on the collapsible tabs: 

 

Minimum Order Limits -  

• Minimum Order Total: If set, the subtotal of products must be at 
least this amount for the coupon to be accepted. 
 

• Minimum Order Quantity: If set, at least this many products must be 
in the cart for the coupon to be accepted. 

 

• Only count applicable products: If checked, only applicable products as configured in the 
“Applicable Products” section will count towards the minimum quantity or total. 

 
Applicable product classes - Selecting a class will apply this coupon to all products of the class, overriding 
other restrictions except for products or terms explicitly excluded below. 
 
Applicable Products - Enter one or more products in the fields to restrict this coupon to a set of products, 
regardless of any product attributes. Discounts will apply to each matching product. Select: 

• Apply coupon to products listed below.  OR 
• Apply coupon to all products except those listed below. 

List your products and click on “Add more items” to add more. 
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Applicable SKUs - Enter one or more SKUs below to restrict this coupon to a set of SKUs, allowing 
coupons to apply to specific products or attribute options. Discounts will apply to matching SKUs. 
Wildcards are supported, e.g. "E*" will match all products with SKUs beginning with E. 
 
Applicable Taxonomy Terms - Enter one or more taxonomy terms (categories) in the fields to restrict 
this coupon to a set of products. Discounts will apply to all matching products with these terms. Select: 

• Apply coupon to products with terms listed below.  OR 
• Apply coupon to all products except those with terms listed below. 

List your products and click on “Add more items” to add more. 
 
User Restrictions - Enter one or more user names and/or "anonymous users" in the fields to make this 
coupon valid only for those users. Select: 

• Allow this coupon only for users listed below. OR 
• Allow this coupon for all users except those listed below. 

 

List users and click on “Add more items” to add more. 
 
Role Restrictions - Enter one or more role names in the fields to make this coupon valid only for users with 
those roles. 

• Allow this coupon only for users with the roles listed below. OR 
• Allow this coupon for users with all roles except those listed below. 

List users and click on “Add more items” to add more. 
 
Deprecated Options - For Wholesale Permissions, select the groups who are 
able to use this coupon. This option is deprecated. It is recommended that you 
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leave this option as "Both wholesale and retail" and use the role selection above instead.  

2. Bulk Coupon Creation 

 
Step 1. When creating your coupon, click on “Bulk coupon codes’’ to enable the bulk generation of coupons. 
Check off “Enable bulk generation of coupon codes.” 
 
You can input a number of codes to generate, and give your coupon code a length. The number of characters 
selected for Code Length will be appended to the original coupon code.  
 

 

Step 2. When you save your coupon, you will see an icon next to your coupon ( )for downloading a CSV of 
generated codes.  

 

3. Managing Coupons 
Step 1. You can see your active and inactive coupons by going to the admin menu, selecting “Administer,” 
“Store Administration,” then “Coupons”. Click “Active Coupons” or “Inactive Coupons.” 

 

Step 2. You can edit or delete your coupon by clicking on the links under Actions. 
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Global Course Reports 

1. Global Report Dashboard 
The global report dashboard shows data for all courses on your site.  

Step 1. To load the report dashboard, click “Administer,”  “Reports,” “Course Reports,”  and then 
“Dashboard” in the admin menu. 

 

 

Step 2. You may print each chart individually by clicking on the printer icon.  You may export each 

chart to a raster or vector image by clicking on this icon:  

 

 

 

 

 



 Reports 
 

  Version 3.3 – November 2013                                                                                              Page 99 of 110 

Step 3. To hide information, click on the links in the small key.  

Example 1: 

Clicking on “Registered” in the key will hide the registered line: 

 

 
 
Only completed records will show.  

 
 

To show the registered information again, re-click on “Registered” in the key. 
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Example 2: 
Clicking on “Physician” in the key will hide the physician section of the pie chart: 

 

 
To show the Physician information again, re-click on “Physician” in the key. 

2. Exporting Reports 
Click on the “Download” link next to the report you would like to download. 
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3. Global Course Report 
The global course report shows data for all enrollments in all courses in your site.  
 
Step 1. In the admin menu, click “Administer,”  “Reports,” “Course Reports,” and then “Course reports”. 
 

 
 
Step 2. You may filter by user name or completion date using the controls at the top of the page.  
 
At any time, the information displayed may be downloaded as a CSV file by clicking on the CSV icon at the 

bottom of the page.  

 

Step 3. To select a subset of courses, click the “Select” tab. 

 

Step 4. This brings you to the Course Selection page. From here, you may filter the list by course title.  

 

Step 5. To add a course to the list, click the checkbox next 
to it.  

Step 6. When you are ready to view the enrollment 
information for all of the selected courses, you may click 
“Select.” You will then be taken to a list of all the student 
enrollments for the courses selected. 

You may download a CSV of this information.  
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Course Reports 

To view reports for a particular course, browse to the course node, and click the "Course Reports" tab. 

1. Reports Dashboard – Course Level 
Click on the “Course Report” tab and the dashboard will load. This dashboard is similar to the Global Report 
Dashboard, but at the course level. Instead of a Credits Earned by week graph, there is a chart for quiz 
completions. 

 

 

 
 

2. Course Objects Report - Quiz 
Step 1. To view Quiz reports, click the “Course objects” sub-tab underneath the “Course Reports” tab.  
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Step 2. Click “Overview” link beneath the quiz title to view detailed reports on each course object.  

Click on the “Export with profile data” link to pull a CSV of user profile and quiz data. 

 
 
 

• Click the user’s grade to 
view the user’s responses for 
that attempt.  

• Click the “Item analysis” link 
to view an aggregate report 
of responses. 

 

 

 

 

• You can delete an attempt 
by checking the box next to 
the user name and using the 
dropdown to select delete. 

• The data can be downloaded 
by clicking one of the 
download options, ODS, 
Excel and text formats are 
available. 
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Step 3. To analyze and compare aggregate responses, click the “Analysis/Compare.” link. 

 
 

Step 4. To compare one quiz with another quiz, select a second quiz from the drop-down menu and click 
“Compare”. You will see response counts and percentages. 

 
You may download the aggregate reports or the individual responses by clicking the buttons at the top right, 
“Download responses,” or “Download comparison.” 
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3. Course Objects Report - Survey  
Step 1: To view the Survey reports, click the “Course objects” sub-tab below the “Course Reports” tab.  

 
 
Step 2: To view you Survey (Evaluation) report, find the name of your survey in the menu and click 
“Summary.” In this example, it is named “Immunotherapy: Changing the Allergic Response Evaluation” 

You can click on the [pdf] link to pull a PDF version of the summary 

The ‘Export with profile data’ link will pull a CSV of evaluation data. 

 

 

 
The summary page appears like this: 

 

The survey report shows an aggregate of all users responses. You may download this in text format and 
import it into Excel. 
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4. Course Objects Report - SCORM  
If you need to see the completion status of a SCORM object, see the SCORM completion report. 
To view the SCORM report, click the "SCORM Report" link. 

 

This is the list of users that have entered the SCORM object: 

 

 
To find out if a user has completed the SCORM object, click the number in the attempt column, next to their 
name. If the user is complete, you will see a green check mark and a status of “passed” or “complete.” 
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5. Credit Awarded By Type Report 
The credit awarded by type report is accessed by clicking the “Course Report” tab and then “Credit awarded 
by type.” 

 

The report shows earned credits by type. If the learner has not yet claimed credit, it is not counted or 
displayed in this report. 
 

 

6. Order Report 
The order report displays orders at the course level that either have a status of ‘Complete’ or ‘Payment 
Received’. This order report will only have data for purchasable courses.  

The order report also displays attribute options that users have selected, if attributes are associated with 
the course. 

Step 1. To view the course report overview, click on the “Course Reports” tab and then “Orders”. 
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Step 2. You will see a list of orders with a status of ‘Complete’ or ‘Payment Received’. You may pull a CSV 

of this information by clicking on the ‘CSV’ button.  

 

7. Course Report Overview 
Step 1. To view the course report overview, click on the “Course Reports” tab and then “Overview”. 

 

This report shows a list of users enrolled in the site, the start and completed date and their status. 

 
 

Step 2.  You may filter through the list of users by Name, and by the “Completed between” dates. Click 
“Apply” to apply. 

 

 
 

Step 3. At the bottom of the Course Report list, you will see a CSV icon. You can download a CSV of the 

course report.  
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PARS 

If PARS is enabled on your site, you will be able to input ACCME content and download PARS reports. 
 
Step 1. ACCME information can be entered when creating a course: 

 
 

Step 2. You may download a PARS Report in XML format by going to the admin menu, clicking on 
“Administer,” “Reports,” and then “PARS”. This PARS report pulls information from all courses. 

 
 
Step 3. Choose the year for which to generate the PARS XML file. Click the “Download” button. 

 

 
Note that when you view the PARS XML, the report will appear to be a string of numbers and characters. 
Your browser may also complain about the page. That is normal. To view the actual XML, right click on the 
page and select “View Source.” 
 
When the report is downloaded, you will receive a .zip file. Inside the file is a report for each reporting year 
the course was accredited for.



 Reporting Bugs  
 

  Version 3.3 – November 2013                                                                                              Page 110 of 110 

Reporting Bugs 

Although we strive to make EthosCE the highest quality application possible, bugs happen. In this section we 
describe how to report bugs to us so we can fix them as quickly as possible. 

We use a web application known as “Mantis” to manage all work for EthosCE. We encourage all clients to 
utilize the Mantis system for reporting any issues and for checking the status of any in issue in progress. The 
system sends emails to us each time the issue is updated, so we are always aware of any changes made to 
the ticket. 

You should already have an account in Mantis created during the development process. If you are new to the 
project and don’t have an account yet, let us know and we will create one for you. 

The URL to log on is: http://mantis.dlc-solutions.com 

If you forget your password, there is a link on this page to help you set a new one. If you cannot remember 
your username, try your first name initial and full last name. If that does not work, contact EthosCE support 
at support@dlc-solutions.com. 

When you log in you should be taken to the My View page, which provides you with a quick summary of 
tickets grouped by status. 

Step 1. On the right hand, upper side is a drop down menu that allows you to select the current project. If 
you have more than one project in development, you need to be sure the correct project is selected when 
performing any actions within Mantis. 

 
Step 2. In the top navigation is a link to the “Report Issue” page, which is used for all new reports going to 
DLC.  Please add as much detail as you can for the summary and the description fields. If you can describe 
what you were doing when you saw the error it will help us replicate it. Operating systems and browser 
versions can be helpful if you are reporting a visual problem or a functional one. Some projects will require 
that you provide URL’s for all tickets. 

When you submit a new ticket it’s not necessary to assign it to anyone, our support staff will take care of 
that.  

Step 3. To view the notes on a ticket you need to scroll down to the bottom of the ticket page. You can edit 
any note you created, and if you have something to add to the issue you can add a new note. 

Below the notes is the complete Issue History, which shows all actions taken on the ticket. You can see who 
has worked on a ticket, who tested the ticket, and who added notes. 

Get Satisfaction 
Please visit our FAQ site to ask general EthosCE questions, and view questions and responses from our other 
EthosCE clients! https://getsatisfaction.com/ethosce 


